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1. Introduction

QGis is a geographic information system (GIS) 
lets us visualize, question, analyse and interpret 
data to understand relationship, patterns and 
trends in space. 

2. Installation
Visit the following link and follow the 
instruction in videos to install QGis:

http://www.qgis.org/en/site/

forusers/download.html 

3. GIS data

Downloading data: 
Use the following step to download the file 
(.shp) that you will use in QGis.

 N.B. QGis works with links. This means that ll 
the file of one project should stay together in 
the same folder. For this reason, keeping track 
of your linked files is absolutely ESSENTIAL! 
We cannot stress this enough. Ensure that all 
of the files that are placed in your document 
can be found in the same folder on your 
computer.

1.	 To download geolocalised data visit :  
http://download.geofabrik.de/

2.	 Select Europe > Great Britain > England > 
Greater London , format [.shp.zip]

3.	 Wait for the file to download. 

4.	 Create a new folder 1_Data_Unzipped and 
right- click to unzip the file.

3.0​​ ​​Downloading​​ ​​data 

3.0.1​ ​Create​ ​a​ ​​new​​ ​​folder​​​ ​called​ ​‘data’.​ ​There​ ​you​ ​will​ ​save​ ​all​ ​the​ ​data​ ​you​ ​are​ ​going ​ ​to​ ​download. 

3.1​​ ​​OpenStreetMap​​ ​​Data  

3.1.1​ ​​Visit​ ​​http://download.geofabrik.de/ 

3.1.2​ ​​Select​​ ​Europe ​ ​>​ ​Great​ ​Britain​ ​>​ ​England ​ ​>​ ​Greater​ ​London ​ ​​,​ ​format​ ​​[.shp.zip] 

3.1.3​ ​Wait​ ​for​ ​the​ ​file​ ​to​ ​download.​ ​Create​ ​a​ ​new​ ​folder​ ​1_Data_Unzipped​ ​and​ ​​right-​ ​click​​ ​to​ ​​unzip​​ ​

the file. 
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Data sources: 
1.	 World
http://download.geofabrik.de/

https://www.openstreetmap.
org/#map=13/51.5306/-0.0395

2.	 UK
https://www.ordnancesurvey.co.uk/
opendatadownload/products.html

https://www.nomiweb.co.uk/

https://www.dft.gov.uk/traffic-counts/
download.php

https://www.data.gov.uk/

https://www.data.london.gov.uk/

3.	 Mapping and visualisation
https://www.viewsofthewoorld.net

https://www.qgis.org/en/site/about/
screenshots.html

4.	 Projection
https://www.epsg-registry.org/

https://www.docs.qgis.org/2.0/en/docs/
gentle_gis_introduction/coordinate_
reference_system.html#on-the-fly-projection
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GIS types of data:
The three types of GIS Data are:

1.	 Spatial data 
•	 Vector data

•	 Point Data — layers containing by 
points (or “events”) described by x,y 
(lat,long; easting, northing)

•	 Line/Polyline Data — layers that 
are described by x,y points (nodes, 
events) and lines (arcs) between 
points (line segments and polylines)

•	 Polygon Data — layers of closed line 
segments enclosing areas that are 
described by attributes. Polygon 
data can be “multipart” like the 
islands of the state of Hawaii.

•	 Raster or grid data (matrices of numbers 
describing e.g., elevation, population, 
herbicide use, etc.

•	 Images or pictures such as remote 
sensing data or scans of maps or other 
photos.  This is special “grid” where 
the number in each cell describes 
what color to paint or the spectral 
character of the image in that cell. (to 
be used, the “picture” must be placed 
on a coordinate system, or “rectified” or 
“georeferenced”)

•	 TINs – Triangular Irregular Networks – 
used to discretise continuous data

•	 Terrain datasets built from lidar and 
other point clouds.Demo in ArcGIS

2.	 Attribute data are non-spatial 
characteristics that are connected by tables 
to points, lines, “events” on lines, and 
polygons (and in some cases GRID cells). 
•	 (a) A point, vector or raster geologic 

map might describe a “rock unit” on 
a map with a single number, letter or 
name, but the associated attribute table 
might have

•	 age

•	 lithology

•	 percent quartz

•	 etc, for each rock type on the map.

•	 (b) Most GIS programs can either plot 
the polygon by the identifier or by one 
of the attributes.

3.	 Metadata
•	 (a) metadata are the most forgotten 

data type.
•	 (b) absolutely necessary if you’re going 

to use data, or if someone is going to 
use your data later (or your derivative 
information).

•	 (c) contains information about

•	 scale

•	 accuracy

•	 projection/datum

•	 data source

•	 manipulations

•	 how to acquire data

•	 (d) many different “standards” for 
collection and presentation of metadata, 
such as FGDC used by US gov’t agencies.



7

Handouts Series     B S P  G R A P H I C  S K I L L S  L A B    |

Vector vs. Raster: 
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Working with RASTER data:

Raster data is quite different from vector data. 
Vector data has discrete features constructed 
out of vertices, and perhaps connected with 
lines and/or areas. Raster data, however, is like 
any image. Although it may portray various 
properties of objects in the real world, these 
objects don’t exist as separate objects; rather, 
they are represented using pixels of various 
different colour values.

Working with VECTOR data:

Vector data is arguably the most common 
kind of data you will find in the daily use of 
GIS. The vector model represents the location 
and shape of geographic features using 
points, lines and polygons (and for 3D data 
also surfaces and volumes), while their other 
properties are included as attributes (often 
presented as a table in QGIS). It is usually used 
to store discrete features, like roads and city 
blocks. The objects in a vector dataset are 
called features, and contain data that describe 
their location and properties.
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GIS Filetypes:



10

B S P  G R A P H I C  S K I L L S  L A B     Handouts Series|

4. Map projections 

Projection, or map projection, is termed as the 
Coordinate Reference System (CRS) or Spatial 
Reference System (SRS) in QGIS. All coordinate 
systems used in GIS are classified into two 
types: Geographic coordinate system, and. 
Projected coordinate system.

Map projections - or Coordinate Reference 
System (CRS) - often cause a lot of frustration 
when working with GIS data. But a proper 
understanding of the concepts and access to 
the right tools will make it much easier to deal 
with projections.

Coordinate reference system: 
Geographic coordinate system:

•	 Degrees of latitude and longitude

•	 Degrees are divided into minutes (‘) and 
seconds (‘‘) 

•	 Most popular WGS 84

Projected coordinate system: 

•	 XYZ coordinates

•	 Cartesian



11

Handouts Series     B S P  G R A P H I C  S K I L L S  L A B    |

Coordinate reference system: 
•	 WGS 84 most popular

•	 OSGB 1936 / British National Grid for 
England 
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5. QGis interface
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Workspace file does not contain any data. It is 
a file which tells QGis which files to open, in 
what order and how they are visualised. It also 
saves print composers.
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The layer selected in the layer panel is the 
active layer, meaning that you can select its 
features or edit it.

Once files are open, they appear in the map 
legend as layers. Note that a layer is not the 
file which is stored.

Layers can be duplicated in order to show 
different visualisation of the same file. 

If you made any changes to the layers and save 
it the changes are saved with it. 

Removing a layer, removes it from the 
workspace but does not delete it from your 
hard drive. 
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Right-click on layer to Open attribute table.
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6. Starting a map

The next steps will guide through the basic 
process to start a project in QGis: 

1.	 Create a new workspace and add all the 
street network data Project > New

2.	 Specify the project CRS: Tick enable on-the-
fly CRS transformation and select British 
National Grid EPSG:27700.

4.​​ ​​0​​ ​​Working​​ ​​with​​ ​​vector​​ ​​layers

4.0.1​ ​​Create​​ ​a​ ​new​ ​workspace​ ​and​ ​add​ ​all​ ​the​ ​street​ ​network​ ​data​ ​​Project​​ ​​​​>​ ​​New  

4.0.2​ ​Specify​ ​the​ ​project​ ​CRS:​ ​​Tick​​ ​​enable​​ ​​on-the-fly​​ ​​CRS​​ ​​transformation​​​ ​and​ ​​select​​ ​​British 

National​​ ​​Grid​​ ​​EPSG:27700.  

4.0.3​ ​​Add​ ​group​​ ​in​ ​the​ ​layer​ ​panel​ ​called​ ​“RCL​ ​maps” 

4.​​ ​​0​​ ​​Working​​ ​​with​​ ​​vector​​ ​​layers

4.0.1​ ​​Create​​ ​a​ ​new​ ​workspace​ ​and​ ​add​ ​all​ ​the​ ​street​ ​network​ ​data​ ​​Project​​ ​​​​>​ ​​New  

4.0.2​ ​Specify​ ​the​ ​project​ ​CRS:​ ​​Tick​​ ​​enable​​ ​​on-the-fly​​ ​​CRS​​ ​​transformation​​​ ​and​ ​​select​​ ​​British 

National​​ ​​Grid​​ ​​EPSG:27700.  

4.0.3​ ​​Add​ ​group​​ ​in​ ​the​ ​layer​ ​panel​ ​called​ ​“RCL​ ​maps” 

3.	 Add group in the layer panel called “RCL 
maps”.

4.	 Add the openstreetmap data that you 
previously downloaded. Select Add Vector 
Layer >

5.	 Navigate in Data > 1_Data_Unzipped> From 
the Fyles of types list select ESRI shapefile.

1

2

3
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Open gis.osm_roads_free_1.shp . To add a 
layer you can also drag and drop the .shp 
file into your map canvas. Drag the layer to 
the ‘RCL maps’ group.

•	 [NOTE]: a shapefile consists of 4 files (.shp, 
.prj, dbf, .shx) and renaming just one of them 
will cause issues. To rename a shapefile you 
need to rename all 4 files.

•	 All OpenStreetMap datasets  are projected 
in a world CRS ( WGS 84 ) which is a 
geographic CRS for the whole world. If you 

4.1​​ ​​Georeferencing​​ ​​a​​ ​​layer  

4.1.1​ ​Add​ ​the​ ​openstreetmap​ ​data​ ​that​ ​you​ ​previously​ ​downloaded.​ ​​ ​​Select​ ​ ​​Add​​ ​​Vector​​ ​​Layer​​ ​​​​> 

Navigate​​ ​​​​in​ ​Data​ ​>​ ​1_Data_Unzipped>​ ​From​ ​the​ ​​Fyles​​ ​​of​​ ​​types​​​ ​list​ ​​select​​ ​​ESRI​​ ​​shapefile​​.​ ​​Open 

gis.osm_roads_free_1.shp​.​​ ​​​​To​ ​add​ ​a​ ​layer​ ​you​ ​can​ ​also​ ​drag​ ​and​ ​drop​ ​the​ ​.shp​ ​file​ ​into​ ​your​ ​map 

canvas.​ ​Drag​ ​the​ ​layer​ ​to​ ​the​ ​‘RCL​ ​maps’​ ​group. 

[NOTE]:​​ ​​​​a​ ​shapefile​ ​consists​ ​of​ ​4​ ​​ ​files​ ​(.shp,​ ​.prj,​ ​dbf,​ ​.shx)​ ​and​ ​renaming​ ​just​ ​one​ ​of​ ​them​ ​will​ ​cause 

issues.​ ​To​ ​rename​ ​a​ ​shapefile​ ​you​ ​need​ ​to​ ​rename​ ​all​ ​4​ ​files.  

​ ​

4.1.2​ ​​ ​All​ ​OpenStreetMap​ ​datasets​ ​are​ ​projected​ ​in​ ​a​ ​world​ ​CRS​ ​(​WGS​​ ​​84​​) ​ ​which​ ​is​ ​a​ ​geographic​ ​CRS 

for​ ​the​ ​whole​ ​world.​ ​If​ ​you​ ​look​ ​at​ ​the​ ​map,​ ​it​ ​looks​ ​slightly​ ​distorted.​ ​We​ ​need​ ​to​ ​reproject​ ​our​ ​layer​ ​to 

use​ ​the​ ​project​ ​CRS​ ​27700​ ​defined​ ​earlier​ ​​(EPSG:27700,​​ ​​OSGB​​ ​​1936/British​​ ​​National​​ ​​Grid)​​.  

4.1.3​ ​Explore​ ​layer​ ​properties: ​ ​​right-click​​ ​on​ ​the​ ​Layer​ ​>​ ​​Properties.​​ ​​General​​ ​​​​>​ ​set​ ​Coordinate 

reference​ ​system​ ​to​ ​​EPSG:4326​​​ ​>​ ​​OK.​​ ​​​​This​ ​is​ ​the​ ​file’s​ ​native​ ​CRS.​ ​The​ ​layer​ ​is​ ​re-projected​ ​​ ​

according​ ​to​ ​the​ ​project​ ​CRS​ ​we​ ​have​ ​defined​ ​previously​ ​​(EPSG:27700)​​.  

4

5

look at the map, it looks slightly distorted. 
We need to re-project our layer to use 
the project CRS 27700 defined earlier 
(EPSG:27700, OSGB 1936/British National 
Grid) .

6.	 Explore layer properties: right-click on 
the Layer > Properties. General > set 
Coordinate reference system to EPSG:4326 
> OK. This is the file’s native CRS. The layer 
is re-projected according to the project CRS 
we have defined previously (EPSG:27700).

4.1.4​ ​It​ ​is​ ​recommended​ ​that​ ​all​ ​layers​ ​in​ ​your​ ​workspace​ ​are​ ​saved​ ​with​ ​the​ ​same​ ​CRS.​ ​To​ ​do​ ​that​ ​for 

a​ ​layer​ ​​right-click​​ ​​Save​​ ​​layer​​ ​​as​​​ ​>​ ​Format:​ ​​ESRI​​ ​​Shapefile​​​ ​>​ ​​Browse​​ ​​​​to​ ​select​ ​the desired​ ​location​ ​

and​ ​save​ ​as​ ​​​ ​​>​ ​CRS:​ ​​Selected​​ ​​CRS​​ ​​(EPSG:27700,​​ ​​OSGB 1936/British​​ ​​National​​ ​​Grid).​​ ​​​​Tick​ ​​Add​​ ​​

saved​​ ​​file​​ ​​to​​ ​​map​​.​ 

4.2​​ ​​Exploring​​ ​​the​​ ​​attributes​​ ​​of​​ ​​layer’s​​ ​​features 

4.2.1​ ​Exploring​ ​the​ ​attributes​ ​table:​ ​​Select​​ ​a ​Layer​ ​​ ​​>​ ​​Open​​ ​​Attribute​​ ​​Table.  Select​​ ​one​ ​random​ ​row​ ​

and​ ​then​ ​go​ ​to​ ​the​ ​main​ ​qgis​ ​window​ ​and​ ​​select​​ ​​zoom​​ ​​to ​​ ​​selection​​.​ ​Then press​​ ​​Deselect​​ ​​Features​​ ​​

from​​ ​​All​​ ​​Layers​​.​ ​​ ​​Select​​ ​the​ ​info​ ​tool​ ​and​ ​check​ ​the​ ​feature’​ ​s​ ​attribute. 4.2.2​ ​Now​ ​​select​​ ​one​ ​feature​ ​

on​ ​the​ ​map​ ​and​ ​look​ ​at​ ​the​ ​table.​ ​​Select​​ ​​Move​​ ​​selection​​ ​​to​​ ​​Top​​​ ​to​ ​bring the​ ​rows​ ​with​ ​the​ ​attributes​ ​

of​ ​the​ ​selected​ ​features​ ​on​ ​top​ ​of​ ​the​ ​attribute​ ​table. 

6
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7.	 It is recommended that all layers in your 
workspace are saved with the same CRS. To 
do that for a layer right-click Save layer as > 
Format: ESRI Shapefile > Browse to select 
the desired location and save as > CRS: 
Selected CRS (EPSG:27700, OSGB 1936/
British National Grid). Tick Add saved file 
to map.

8.	 To explore the attributes table: Select a 
Layer > Open Attribute Table. Select one 
random row and then go to the main Qgis 
window and select zoom to selection . 

9.	 Then press Deselect Features from All 
Layers . Select the info tool and check the 
feature’ s attribute. 4.2.2 Now select one 
feature on the map and look at the table. 
Select Move selection to Top to bring the 
rows with the attributes of the selected 
features on top of the attribute table.

10.	Select the layer to edit > Toggle editing. 
Right-click > Layer properties > Fields > 
Add Field with name ‘name’ , type text and 
length 20 .

11.	Right-click > Open Attribute table . Set 
this windows aside and update each point 
data with the name of the stations. Save 
the changes > Toggle editing.

12.	Right-click on the layer and go to Labels. 
Labels visualise the selected attributes of 
features in the map canvas. Select Show 
labels for this layer. Select Label with 
‘name’. You may want to adjust text and 
placement options.

8

9
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4.8.1​ ​​Select​ ​the​ ​layer​​ ​to​ ​edit​ ​>​​​ ​​Toggle​​ ​​editing.​​ ​​​​Right-click​​ ​>​ ​L​ayer​​ ​​properties​​ ​​​​>​ ​​ ​​Fields​​ ​​>​​ ​​Add​​ ​​Field 

with​ ​name​ ​​‘name’​​,​ ​type​ ​​text​​​ ​and​ ​length​ ​​20​​.  

Right-click​​ ​>​ ​Open​ ​​Attribute​​ ​​table​​.​ ​Set​ ​this​ ​windows​ ​aside​ ​and​ ​update​ ​each​ ​point​ ​data​ ​with​ ​the​ ​name 

of​ ​the​ ​stations​ ​as​ ​shown​ ​in​ ​the​ ​image​ ​in​ ​4.3.6.​ ​Save​ ​the​ ​changes​ ​>​ ​​Toggle​​ ​​editing.  

4.8.2​ ​​Right-click​ ​​on​ ​the​ ​layer​ ​and​ ​go​ ​to​ ​​Labels​​.​ ​Labels​ ​visualise​ ​the​ ​selected​ ​attributes​ ​of​ ​features​ ​in 

the​ ​map​ ​canvas.​ ​​Select​​ ​​Show​​ ​​labels​​ ​​for​​ ​​this​​ ​​layer​​.​ ​​Select​​ ​​Label​​ ​​with​​​ ​‘name’.​ ​​ ​You​ ​may​ ​want​ ​to 

adjust​ ​text​ ​and​ ​placement​ ​options.  

4.8​​ ​​Editing​​ ​​the​​ ​​layer​​ ​​data​​ ​​-​​ ​​attributes 

4.8.1​ ​​Select​ ​the​ ​layer​​ ​to​ ​edit​ ​>​​​ ​​Toggle​​ ​​editing.​​ ​​​​Right-click​​ ​>​ ​L​ayer​​ ​​properties​​ ​​​​>​ ​​ ​​Fields​​ ​​>​​ ​​Add​​ ​​Field 

with​ ​name​ ​​‘name’​​,​ ​type​ ​​text​​​ ​and​ ​length​ ​​20​​.  

Right-click​​ ​>​ ​Open​ ​​Attribute​​ ​​table​​.​ ​Set​ ​this​ ​windows​ ​aside​ ​and​ ​update​ ​each​ ​point​ ​data​ ​with​ ​the​ ​name 

of​ ​the​ ​stations​ ​as​ ​shown​ ​in​ ​the​ ​image​ ​in​ ​4.3.6.​ ​Save​ ​the​ ​changes​ ​>​ ​​Toggle​​ ​​editing.  

4.8.2​ ​​Right-click​ ​​on​ ​the​ ​layer​ ​and​ ​go​ ​to​ ​​Labels​​.​ ​Labels​ ​visualise​ ​the​ ​selected​ ​attributes​ ​of​ ​features​ ​in 

the​ ​map​ ​canvas.​ ​​Select​​ ​​Show​​ ​​labels​​ ​​for​​ ​​this​​ ​​layer​​.​ ​​Select​​ ​​Label​​ ​​with​​​ ​‘name’.​ ​​ ​You​ ​may​ ​want​ ​to 

adjust​ ​text​ ​and​ ​placement​ ​options.  

4.8​​ ​​Editing​​ ​​the​​ ​​layer​​ ​​data​​ ​​-​​ ​​attributes 
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